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CERTIFICATE IN GRAPHIC DESIGNING

DURATION: 4 MONTHS

CORELDRAW
+ CorelDraw Basics And Interface
+Working on Layer
+ Working on objects with its properties
« Working on Drawing tools
« Working on Tools with its Shortcut
+ Transforming Objects
+ Qutlining & Filling Objects
* Tracing & some other Effects
* Blending Objects
“ Applying Distortions
“ Applying Mesh Fills
“ Working with Text
* Layer Setup & printing
“ Import and Export

PHOTOSHOP
+ Explain interface with Layers
+ Making Selections with its inverse
+ Working with Mask
+Working on Paths
+ Create & Modify path
+ Remove and change the background
* Working on Tools
+ Special Effects
* Layer Setup & printing
* Import and Export

INDESIGN
“ Explain interface with page
“ Working on Tools and menus
* Setup documents and page size
“* Header & Footer
“Working On Master Pages
“ Creating table of contents
“Working on Text with its properties & Effects
* Import and Editing Text
“ Working on Images
“Working on Frames
* Working on Table
* Transparency
“Vector Graphics practices
“ Working on paragraph and characters
* Page & Print Setup
“ Exporting

ILLUSTRATOR
« lllustrator Basics with its interface
« Selections
« Working on Layers
« Working on Rulers and Guide
« Working on Stroke & color Filling
« Special Effects
+ Working on Drawing Tools
+ Working on Pen Tool
+ Working with Mask
+ Working on Paths
+ Working on Tools & Text
+ Import and Export

ASSIGNMENTS
PORTFOLIO SUBMISSION
PRESENTATION

FINAL EXAM

JOB OPPORTUNITIES

= GRAPHIC DESIGNER
= DTP OPERATOR
= BOOK PUBLISHER

CERTIFICATE IN DATA ENTRY

OPERATOR
DURATION: 4 MONTHS

COMPUTER FUNDAMENTALS
WINDOWS & OPERATING SYSTEM
TYPING SKILLS(40 WPM)
OUTLOOK EXPRESS

MS-WORD

Introduction of Word with its Interface
Explain Tabs Briefly

+ Shortcuts

“Mail merge

* Page Setups(Page visualization&printing)
“ Protections & Macros

2
2

MS-EXCEL
* Introduction of Excel
“Explain Interface
< Shortcuts
* Diff b/w Functions & Formulas
* Cell references
“ Qperators
“ Basic Calculations
* Text Function
* Date & Time Function
*Mathematic Function
“ Logical Function
* Conditional formatting
* Charts
“ Reports using Pivot Table
* Protections

MS- POWERPOINT
< Introduction of PowerPoint
« Explain Interface
< Shortcuts
*Explain Tabs
* Quiz Making
“ Designing & Formatting
* Transitions
* Album creation
* Animations
* Slide Master

MS- ACCESS
+Introduction of Access
+ Explain Interface
« Explain Tabs



+ Table(Design & Datasheet)

* Applying Data types on fields
« Constraints

« Wild Cards

“ Form

* Queries

* Reports

“ Applying wild cards on Queries
“ Applying Relationship on table
“ Macro

UNDERTAKE DATA ENTRY SERVICES
ROLE OF DATA ENTRY OPERATOR
MANAGE WORK

INTERVIEW TECHNIQUES
ASSIGNMENTS & PRESENTATION
EXAM & TYPING TEST (40 WPM)

JOB OPPORTUNITIES

= COMPUTER OPERATOR
= DATA ENTRY OPERATOR

CERTIFICATE IN ADV. DATA ENTRY

OPERATOR
DURATION: 5 MONTHS
COMPUTER FUNDAMENTALS
WINDOWS & OPERATING SYSTEM
TYPING SKILLS (40 WPM)
OUTLOOK EXPRESS

MS-WORD
~ Introduction of Word with its Interface
- Explain Tabs Briefly
-~ Shortcuts
« Mail merge
« Page Setups(visualization & printing)
« Protections & Macros

X3

X3

X3

MS-EXCEL
# |Introduction of Excel
> Explain Interface
» Shortcuts
> Diff b/w Functions & Formulas
- Cell references
> Operators
» Basic Calculations
» Text Function
» Date & Time Function
» Mathematic Function
“ Logical Function
“ Conditional formatting
» Charts & Reports using Pivot Table
» Protections

P e G e e e e

X3

X3

X3

X3

MS- POWERPOINT
. Introduction of Power point
. Explain Interface
- Shortcuts
« Explain Tabs
« Quiz Making

X3

X3

X3

+Designing & Formatting
+Transitions

<« Album creation

<+ Animations

+Slide Master

MS- ACCESS

*Introduction of Access
*Explain Interface

“Explain Tabs

*Table(Design & Datasheet)
“Applying Data types on fields
“Constraints

“Wild Cards

“Forms & Reports

“ Applying wild cards on Queries
“Applying Relationship on table
“Queries & Macro

%
X7

%
X7

UNDERTAKE DATA ENTRY SERVICES
ROLE OF DATA ENTRY OPERATOR
MANAGE WORK

ADVANCED EXCEL

« Advanced Shortcuts

+ Advanced Conditional Formatting

« Advanced Functions

« Lookup & Reference Functions(vlookup,

hlookup,index,match,double vlookup, vlookup with
match,hlookup with match, index with match &
xlookup)

«Depreciations & Garbage Cleaning

«Errors

+Reports (Pivot Table, Charts with slicer & time line)
+Working with Templates

«8orting and Filtering Data

+Restrictions

+What If Analysis

« Array Calculation

“Database Function

*Macro for automation

“Advanced Protections & Printing Techniques

INTERVIEW TECHNIQUES
ASSIGNMENTS

PROJECT WITH PRESENTATION
EXAM & TYPING TEST (40 WPM)

JOB OPPORTUNITIES

= COMPUTER OPERATOR
= DATA ENTRY OPERATOR
= BACK-END EXECUTIVE

CERTIFICATE IN WEB DESIGNING
DURATION: 6 MONTHS
MODULE 1: 3 MONTHS
HTML

# Introduction & Structure of HTML

« Tags & its implementation

&

&

Attributes & Elements
Formatting
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« Lists & Tables
+ Form Design & validation
+ Calculator

1

¥

CSS
« Introduction of css
«How to use CSS
« CSS Types & Selectors
« Margins & Padding in CSS
« Animation using CSS
«2D & 3D CSS
« Navigation & Drop-down
« Progress Bar
« Slideshow
+ CSS Effects & Layout
+ Pseudo classes & element
+Web Layout Design

PHOTOSHOP
« Explain interface with Layers
« Making Selections with its inverse
+ Working with Mask
« Working on Paths
+ Create & Modify path
+ Remove and change the background
« Working on Tools
+ Special Effects
« Layer Setup & printing
« Import and Export

DREAMWEAVER
« Defining a local site
« Creating a page in Layout view
+ Inserting an image and a rollover image
« Working with tables in Standard view
« Creating a link to another document
* Inserting assets from the Assets panel
+ Inserting Flash Text and Flash Button objects
« Creating and applying a template
+ Running a site report
« Adding a Design Note

FUNCTIONAL COMMUNICATION
ASSIGNMENTS

PRESENTATION

EXAM OF MODULE 1

MODULE 2:

JAVASCRIPT
« Basic Programming
« Working with logical part of programming
« Variables & Constants
« Data types & Operators
« Control Statement
+ Looping
« Switch case
+ Functions
« JavaScript Implementation with HTML
+ Events & Form Handling

3 MONTHS

JQUERY
“ JQuery Basic

« Elements with JQuery
« Effects & Events

WORDPRESS
« Introduction to build dynamic website and blogs
« Installation of Word press on web server
« Download and Install Add-ins Tools
+Working on Tools
«Working on Themes
« Create, Update and Manage website
« Edit, Publish, and Modify the content of the website

BOOTSTRAP
« Bootstrap Introduction
« Bootstrap Templates
«Working with HTML,CSS & JS with Bootstrap

ASSIGNMENTS

INTERVIEW TECHNIQUES
PROJECT WITH PRESENTATION
FINAL EXAM

JOB OPPORTUNITIES

= WEB DESIGNER

CERTIFICATE IN COMPUTERIZED

ACCOUNTING
DURATION: 6 MONTHS
MODULE 1: 3 MONTHS
COMPUTER FUNDAMENTALS
WINDOWS & OPERATING SYSTEM
OUTLOOK EXPRESS

MS-WORD
< Introduction of Word with its Interface
“ Explain Tabs Briefly
“ Shortcuts
“ Mail merge
*Page Setups
“ Protections & Macros

MS-EXCEL
+ Introduction of Excel
« Explain Interface
« Shortcuts
« Diff b/w Functions & Formulas
< Cell references
« QOperators & Basic Calculations
= Text Function
# Date & Time Function
< Mathematic Function
+Logical Function
+ Conditional formatting
+ Charts & Reports using Pivot Table
+ Protections

MS- POWERPOINT
« Introduction of Powerpoint
« Explain Interface
« Shortcuts
« Explain Tabs



+ Quiz Making

+ Designing & Formatting

+ Transitions & Animations

< Album creation

< Animations

« Slide Master
FUNCTIONAL COMMUNICATION
ASSIGNMENTS & PRESENTATION
EXAM OF MODULE 1

MODULE 2: 3 MONTHS
PRE ACCOUNTING

ADVANCED EXCEL

« Advanced Shortcuts

+ Advanced Conditional Formatting

« Advanced Functions

« Lookup & Reference Functions(vlookup,
hlookup,index,match,double vlookup, vlookup with
match,hlookup with match, index with match & xlookup)

+ Depreciations &Garbage Cleaning

« Errors

+ Reports( Pivot Table & Pivot Charts with slicer&timeline)

« Working with Templates

« Sorting and Filtering Data

+ Restrictions

« What If Analysis

+ Array Calculation

+ Database Function

+ Macro for automation

+ Advanced Protections & Print Technique

TALLY PRIME
+ Basic Accounting Practice
« Tally & Versions
« Computerized Accounting
« Charts of Accounts
« Accounting Management
« Inventory Management
« Order Processing & Vouchers
« Payroll
« Banking Features
< Budget
« Back-up & Restore Data
+ Job Costing & Advanced Features
«Taxes : TDS , TCS
« GST

ASSIGNMENTS

INTERVIEW TECHNIQUES
PROJECT WITH PRESENTATION
EXAM OF MODULE 2

JOB OPPORTUNITIES

= COMPUTER OPERATOR

= DATA ENTRY OPERATOR
= ACCOUNTANT
=
=

GST EXECUTIVE
TALLY OPERATOR
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DIPLOMA IN DIGITAL MARKETING
DURATION: 6 MONTHS

MODULE 1 3 MONTHS

DIGITAL MARKETING PRO
+ Introduction to Digital Marketing
+ Understanding Digital Marketing.
+ Digital Marketing Components.
+ Content Basics
+Logo
“Website Banners
“ Social Media Post
*Image, Carousel and Graphic Designing (Canva)
+Video Content
+Render Forest
= Article Writing and Blogging
+ Types of articles
+ Type of blogging
+ Social Media Marketing Basics and Paid Ads and
* Content Strategy
* Platforms of SMM
“Website Designing with Zero Programming
“ Types of website , domains & Hosting
“ SEM-Google Ads
“ Analytics and Conversion Tracking
“Types of data in google analytics
“How to get clients & prepare quotations

FUNCTIONAL COMMUNICATION
PROJECT & ASSIGNMENTS
EXAM OF MODULE 1

MODULE 2: 3 MONTHS

DIGITAL MARKETING EXECUTIVE
« Affiliate Marketing
+ Search Engine Optimization & Marketing
+ SOCIAL MEDIA MARKETING
+Face book, Twitter, Linkedin & Instagram Marketing
+Video Marketing
* Pinterest Marketing
+ Google ad words
* Mobile Marketing Learning
+ Content Marketing
* Email Marketing
« LSl (latent semantic Indexing)
+ Google analytics
+ Remarketing audience
“ Online marketing strategy
“ Live Project
INTERVIEW TECHNIQUES
FINAL PROJECT & ASSIGNMENT FINAL EXAM

JOB OPPORTUNITIES

ONLINE ENTREPRENEUR
ONLINE LEAD MANAGER
CONTENT MARKETER

SOCIAL MEDIA EXPERT

EMAIL MARKETING

DIGITAL MARKETING MANAGER

R RURURURY
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PROF. DIPLOMA IN MANAGEMENT

INFORMATION SYSTEM
DURATION: 7 MONTHS

1

¥

MODULE 1:

MS-EXCEL
+ Introduction of Excel
« Explain Interface
« Shortcuts
+ Diff b/w Functions & Formulas
- Cell references
Operators
Basic Calculations
# Functions
« Conditional formatting
« Charts & Reports using Pivot Table
+ Protections

3 MONTHS

X3

0y
X7

%
X7

ADVANCED EXCEL

« Advanced Shortcuts

« Advanced Conditional Formatting

« Advanced Functions

« Lookup & Reference Functions(viookup,

« hlookup,index,match,doubleviookup, viookup with

+ match,hlookup with match, index with match & xlookup)

« Depriciation

+ Garbage Cleaning

+ Reports Using Pivot Table & Charts with slicer and
timeline

“ Working with Templates

+ Sorting and Filtering Data

* Restrictions & Errors

* What If Analysis & Array Calculation

* Database Function

* Macro for automation

* Advanced Protections & Print Technique

MS- ACCESS
Introduction of Access
Explain Interface

“ Explain Tabs

“ Table(Design & Datasheet)
“ Applying Data types on fields
“ Constraints

* Wild Cards

“ Forms & Reports

* Queries

* Applying wild cards on Queries
“ Applying Relationship on table

* Macro

o2
o2

ASSIGNMENTS
FUNCTIONAL COMMUNICATION
EXAM OF MODULE 1

MODULE 2:

VBA
« Introduction of VBA
+ Introduction to Developer tab
+ Introduction to Macro Recordings
+ Working In the Visual Basic Editor
+ Introducing the Excel Object Model

3 MONTHS

* VBA Excel Macros Programming

* Variable, Const, Operators & Data types

* Input Output Operations

“ Control Statement

* Loops & Select Case

“* Arrays

+ Functions and Sub Procedure
* Errors & its handling

« User Forms Events(GUI)

< Charts & Dashboards With VBA Macors

MYSQL
# SQL Introduction
<« SQL DML Commands
<« SQL DDL Commands
+ SQL Clauses
« SQL Logical Operations
« SQL Aggregate Functions
+« SQL Wildcards
<« SQL Aliases
+ SQL Joins
= SQL Case
“ SQL Stored procedures
* SQL Comments
“ SQL Triggers
“SQL

ASSIGNMENTS
PROJECT WITH PRESENTATION
EXAM OF MODULE 2

MODULE 3:

POWER BI
« Introduction of Power BI
« Interface of Power BI
« Power Bl Mobile Apps
« Power Bl Services
« Export data in Power Bl
+ Shaping and Combining Data
+ Modeling Data
“ Analyzing Data
* Visualizing Data
“ Interactive Data Visualization
“ Power Bl Dta Sources
“ Relationships
“ Calculations
“* Working on Tools
“ Creating Power Bl Reports

ASSIGNMENTS

INTERVIEW TECHNIQUES
PROJECT WITH PRESENTATION
FINAL EXAM

JOB OPPORTUNITIES

= DATA ENTRY OPERATOR
= MIS EXECUTIVE

= BACK-END EXECUTIVE
= DATA ANALYST

1 MONTH



PROF. DIP. IN COMPUTERIZED ACCOUNTING *Advanced Conditional Formatting

DURATION: 8 MONTHS “ Advanced Functions
. “Lookup & Reference Functions(vlookup,
e HMONTHS hlookup,index,match,double vlookup, viookup with
COMPUTER FUNDAMENTALS match,hlookup with match, index with match &
WINDOWS & OPERATING SYSTEM xlookup)
OUTLOOK EXPRESS * Depreciation
“ Garbage Cleaning
MS-WORD “Errors
« Introduction of Word with its Interface * Reports(Pivot Table & Charts with slicer & timeline)
« Explain Tabs Briefly +Working with Templates
+ Shortcuts * Sorting and Filtering Data
* Mail merge * Restrictions
+ Page Setups(Page visualization & printing) *What If Analysis
* Protections & Macros * Array Calculation
“ Database Function
MS-EXCEL * Macro for automation
+ Introduction of Excel * Advanced Protections & Print Technique
« Explain Interface
« Shortcuts TALLY PRIME
+ Diff b/w Functions & Formulas +Basic Accounting Practice
« Cell references « Tally & Versions
+ Operators & Basic Calculations + Computerized Accounting
+ Functions « Charts of Accounts
+ Conditional formatting +Accounting Management
+ Charts & Reports using Pivot Table +Inventory Management
* Protections * Order Processing & Vouchers
« Payroll
MS- POWERPOINT « Banking Features
* Introduction of Power point +Back-up & Restore Data
« Explain Interface «Job Costing
+ Shortcuts « Advanced Features
« Explain Tabs «~Taxes : TDS , TCS
* Quiz Making «GST
+ Designing & Formatting
* Transitions & Animations BUSY
+ Album creation + Basic Accounting Practice
+ Animations + Computerized Accounting
+ slide master + Charts of Accounts
+ Accounting Management
MS- ACCESS * Inventory Management
+ Introduction of Access *Order Processing
« Explain Interface +Vouchers
« Explain Tabs Payrc_)ll
+ Table(Design & Datasheet) +Banking Features
+ Applying Data types on fields +Advanced Features
« Constraints «TDS & GST
« Wild Cards
+ Form, QueriesReports ASSIGNMENTS
+ Applying wild cards on Queries INTERVIEW TECHNIQUES
K App]ymg Re|ationship on table PROJECT & PRESENTATION
+ Macro FINAL EXAM

FUNCTIONAL COMMUNICATION JOB OPPORTUNITIES

ASSIGNMENTS & PRESENTATION = COMPUTER OPERATOR
EXAM OF MODULE 1 = DATA ENTRY OPERATOR
PRE ACCOUNTING GST EXECUTIVE

= TALLY OPERATOR

ADVANCED EXCEL
<« Advanced Shortcuts
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PROF. DIPLOMA IN PRE & POST
ACCOUNTING
DURATION: 8 MONTHS
MODULE 1: 4 MONTHS

PRE -ACCOUNTING

ADVANCED EXCEL

> Advanced Shortcuts

> Advanced Conditional Formatting

» Advanced Functions

> Lookup & Reference Functions(viookup,

> hlookup,index,match,double vio

» okup, vlookup with match,hlookup with match,
» index with match & xlookup)

* Depreciation

» Garbage Cleaning

* Errors

- Reports(Pivot Table & Pivot Chart with slicer & timeline)
» Working with Templates

- Sorting and Filtering Data

» Restrictions

~ What If Analysis

- Array Calculation

- Database Function

» Macro for automation

» Advanced Protections & Print Technique

TALLY PRIME

- Basic Accounting Practice
- Tally & Versions

-~ Computerized Accounting
« Charts of Accounts

« Accounting Management
« Inventory Management

« Order Processing

« Vouchers

« Payroll

« Banking Features

» Budget

» Back-up & Restore Data

» Job Costing

» Advanced Features

- Taxes : TDS, TCS & GST

BUSY

~ Basic Accounting Practice

» Computerized Accounting

- Charts of Accounts

- Accounting Management

> Inventory Management

- Order Processing & Vouchers
» Payroll

» Banking Features

» Advanced Features

> TDS & GST

FUNCTIONAL COMMUNICATION
ASSIGNMENTS & PRESENTATION
PROJECT

EXAM OF MODULE 1

MODULE 2: 4 MONTHS
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POST ACCOUNTING

INCOME TAX
Introduction of income tax

<« Manual tax calculation,prepaid tax and interest

<« Comp. & E--filling of ITR-01-theory & practical

« Comp. & E--filling of ITR-02 (HP & 01)-theory &

< practical

« Comp. & E-filling of ITR-02 (CG and agriculture)
« Comp. of PGBP

« (proprietor)and E-Filling of ITR-03 Computation of
« persumptive income & E-Filling ITR-04

Computation of partnerships firm and E-filling of
ITR-05
Companies return with ITR-06

« Online -PAN filling & E-filling Reg.

GST
Introduction -goods & service(GST)

+ Types of GST and tax payer
+ Scope of supply,place and time of supply and

invoice

Input tax credit(ITC)

Payment in GST & Registration migration(new user)
Composition scheme and GST

RCM-Reverse charge mechanism

E-way bill and GST

computation and practical assignment

TDS

« Introduction & Process Payment other salary-26Q
« TDS return -26Q & 24Q

« Salary component with payroll

« Tax Collection at source (TCS)

Payment to non-resident-27Q

About traces website

Interest and penalty

TDS on rent of property

TAN (tax deduction and collection account number)

ROC(REG. OF COMPANY)

« Introduction of MCA

+ Types Of Company

+ How to register new company online
+ How to apply DIN

* Incorporation & E-filling of company
« payment in ROC fees

Issue Certificates of incorporation

ASSIGNMENTS

INTERVIEW TECHNIQUES
PROJECT & PRESENTATION
FINAL EXAM

JOB OPPORTUNITIES

DATA ENTRY OPERATOR
ACCOUNTANT

GST EXECUTIVE

TALLY OPERATOR
SENIOR ACCOUNTANT

41881818




PROF. DIPLOMA IN DOCUMENTATION &

GRAPHIC DESIGNING
DURATION: 8 MONTHS
MODULE :1 4 MONTHS
COMPUTER FUNDAMENTALS
WINDOWS & OPERATING SYSTEM
OUTLOOK EXPRESS
MS-WORD
Introduction of Word with its Interface
Explain Tabs Briefly
Shortcuts
Mail merge
Page Setups(Page visualization & printing)
+ Protections & Macros

PN SR S N
SO K

MS-EXCEL
< Introduction of Excel
Explain Interface
Shortcuts
Diff b/w Functions & Formulas
Cell references
Operators & Basic Calculations
Functions
Conditional formatting
Charts & Reports using Pivot Table
Protections

% e o e e o e O o
SRR S . A4

MS- POWERPOINT
Introduction of Power point
Explain Interface
Shortcuts

Explain Tabs

Quiz Making

Designing & Formatting
Transitions & Animations
Album creation

“ Animations

* slide master

% S f e e O o o
CEER R R 4

MS- ACCESS
+ Introduction of Access
Explain Interface
Explain Tabs
* Table(Design & Datasheet)
Applying Data types on fields
Constraints& Wild Cards
Form, Queries & Reports
Applying wild cards on Queries
Applying Relationship on table
* Macro
FUNCTIONAL COMMUNICATION
ASSIGNMENTS & PRESENTATION
EXAM OF MODULE 1

0y
X7

0y
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MODULE :1
GRAPHIC DESIGNING
CORELDRAW

« CorelDRAW Basics And Interface

« Working on Layer

+ Working on objects with its properties
+ Working on Drawing tools

4 MONTHS

X3
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“ Working on Tools with its Shortcut
* Transforming Objects

“ Outlining & Filling Objects

“ Tracing & some other Effects

“ Blending Objects

“ Applying Distortions

“ Applying Mesh Fills

> Working with Text

> Layer Setup & printing

“ Import and Export

PHOTOSHOP

» Explain interface with Layers

» Making Selections with its inverse

> Working with Mask

» Working on Paths

> Create & Modify path

+ Remove and change the background
+ Working on Tools

« Special Effects

» Layer Setup & printing

» Import and Export

INDESIGN

* Explain interface with page

* Working on Tools and menus

* Setup documents and page size

* Header & Footer

* Working On Master Pages

> Creating table of contents

> Working on Text with its properties & Effects
» Import and Editing Text

= Working on Images

* Working on Frames & Table

* Transparency

* Vector Graphics practices

“ Working on paragraph and characters
“ Page & Print Setup

“ Exporting

ILLUSTRATOR

* lllustrator Basics with its interface
> Selections

* Working on Layers

* Working on Rulers and Guide

* Working on Stroke & color Filling
> Special Effects

» Working on Drawing Tools

* Working on Pen Tool

* Working with Mask

* Working on Paths

* Working on Tools & Text

* Import and Export

ASSIGNMENTS
PORTFOLIO SUBMISSION
PRESENTATION

FINAL EXAM

JOB OPPORTUNITIES

= DATA ENTRY OPERATOR
= GRAPHIC DESIGNER
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E-DIPLOMA IN COMPUTERIZED
ACCOUNTING & E-TAXATION

DURATION: 12 MONTHS
MODULE 1:

COMPUTER FUNDAMENTALS
WINDOWS & OPERATING SYSTEM
OUTLOOK EXPRESS

MS-WORD
+ Introduction of Word with its Interface
« Explain Tabs Briefly
< Shortcuts
« Mailmerge
« Page Setups(Page visualization & printing)
« Protections
<« Macros

MS-EXCEL
+ Introduction of Excel
« Explain Interface
+ Shortcuts
« Diff b/w Functions & Formulas
« Cell references
« Operators
+ Basic Calculations
« Text Function
« Date & Time Function
<« Mathematic Function
+ Logical Function
+ Conditional formatting
< Charts
+ Reports using Pivot Table
<+ Protections

MS- POWERPOINT
« Introduction of Power point
« Explain Interface
« Shortcuts
« Explain Tabs
+ Quiz Making
« Designing & Formatting
« Transitions & Animations
< Album creation
+ Animations
« slide master

MS- ACCESS
« Introduction of Access
« Explain Interface
« Explain Tabs
+ Table(Design & Datasheet)
+ Applying Data types on fields
+ Constraints
< Wild Cards
Form
* Queries
* Reports
* Applying wild cards on Queries
“ Applying Relationship on table
+ Macro

%
X7

4 MONTHS

FUNCTIONAL COMMUNICATION
ASSIGNMENTS & PRESENTATION
EXAM OF MODULE 1

MODULE 2: 4 MONTHS
PRE ACCOUNTING

ADVANCED EXCEL

* Advanced Shortcuts

* Advanced Conditional Formatting

* Advanced Functions

* Lookup & Reference Functions(vlookup,
hlookup,index,match,double vlookup, viookup with
match,hlookup with match, index with match &
xlookup)

“ Depreciation & Garbage Cleaning

“ Errors

“ Reports(Pivot Table & Chart with slicer & timeline)

“* Working with Templates

“ Sorting and Filtering Data

“ Restrictions

* What If Analysis

“ Array Calculation

* Database Function

“ Macro for automation

* Advanced Protections & Print Technique

TALLY PRIME
+ Basic Accounting Practice
* Tally & Versions
* Computerized Accounting
* Charts of Accounts
“ Accounting Management
“ Inventory Management
“ Order Processing
“ Vouchers
“ Payroll
“ Banking Features
“ Budget
“ Back-up & Restore Data
“ Job Costing
* Advanced Features
* Taxes : TDS, TCS GST

BUSY
+ Basic Accounting Practice
* Computerized Accounting
* Charts of Accounts
* Accounting Management
* Inventory Management
* Order Processing
* Vouchers
“ Payroll
“ Banking Features
“ Advanced Features
“ TDS
“ GST

ASSIGNMENTS

WORK READINESS SOFTSKILLS
PROJECT & PRESENTATION
EXAM OF MODULE 2
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MODULE :3
POST ACCOUNTING

4 MONTHS

INCOME TAX

Introduction of income tax

Manual tax calculation,prepaid tax and interest

Comp. & E--filling of ITR-01-theory & practical

Comp. & E-filling of ITR-02 (HP & 01)-theory & practical
Comp. & E-filling of ITR-02 (CG and agriculture)
Comp. of PGBP (proprietor)and E- '

Filling of ITR-03 Computation of persumptive income &
E-Filling ITR-04

Computation of partnerships firm and E-filling of ITR-05
Companies return with ITR-06

Online -PAN filling & E-filling Reg.

TDS

Introduction & Process Payment other than salary-26Q
TDS return -26Q

Salary component with payroll

TDS return -24Q

Tax Collection at source (TCS)

Payment to non-resident-27Q

About traces website

Interest and penalty

TDS on rent of property

TAN (tax deduction and collection account number)

GST

“ Introduction -goods & service(GST)
“ Types of GST and tax payer

* Scope of supply,place and time of supply and invoice

Input tax credit(ITC)

* Paymentin GST

% ot o o
SR

Registration migration and new user
Composition scheme and GST
RCM-Reverse charge mechanism
E-way bill and GST

computation and practical assignment

ROC(REG. OF COMPANY)
Introduction of MCA

Types Of Company

How to register new company online
How to apply DIN

Incorporation & E-filling of company
payment in ROC fees

« Issue Certificates of incorporation

ASSIGNMENTS
FINAL PROJECT&PRESENTATION
FINAL EXAM

JOB OPPORTUNITIES

COMPUTER OPERATOR
DATA ENTRY OPERATOR
ACCOUNTANT

GST EXECUTIVE

TALLY OPERATOR
SENIOR ACCOUNTANT
TAX CONSULTANT

SRR R R R R
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PROF. DIPLOMA IN SOFTWARE

DEVELOPMENT
DURATION: 12 MONTHS
MODULE 1: 3 MONTHS

C LANGUAGE

Introduction of C with its Syntax
Variables, Data Types and Operators
Input Output Operation

+ Control Statements

+ Loop

* Arrays
+ Structure & Union

PN S S N
SO S X4

Sorting Techniques
Functions

Recursion & Pointers
File Handling

C++ LANGUAGE

Introduction of C++ with its syntax
Variables, Data Types and Operators
Input Output Operation

Control Statements

Loop

Structure & Union

* Function & Recursion
* Pointers

% e o ot e O N
SR 4

% S O e e o e O e e o
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+ Strings (Group of Characters)

Object Oriented Programming Language
Class & Object

Inheritance

Abstraction

Polymorphism

Encapsulation

Interfaces

Constructor and Destructor
Multithreading

File & Exception Handling

FUNCTIONAL COMMUNICATION
ASSIGNMENTS

PROJECT WITH PRESENTATION
EXAM OF MODULE 1

MODULE 2: 3 MONTHS
CORE JAVA

Introduction to Java

Variables & Data Types

Operators & Expression

Input Output Operations

Control Statement

Jump Statement

Loop

Functions

OOPS Part

String & Array

Data Structure

Packages

File & Exception Handling

AWT & Swing
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ASSIGNMENTS
PROJECT WITH PRESENTATION
EXAM OF MODULE 2

MODULES:

PYTHON
> Introduction to Python
> Python Environment Setup and Essentials
» Variables & Data Types
» Operators & Expression
> Input Output Operations
» List & its implementations
> Tuple & its implementation
> Dictionary & its implementation
« Strings
« Control Statement
+ Loops & Jump Statements
+ Sorting Techniques
* Functions
* Recursion
* Lambda Function
* Libraries and Modules

@ G e e G e

MYSQL

» SQL Introduction

~ SQL DML Commands

~ SQL DDL Commands

» SQL Clauses

» SQL Logical Operations

» SQL Aggregate Functions

~ SQL Wildcards

« SQL Aliases

<+ SQL Joins

+ SQL Case

* SQL Stored procedures

+ SQL Comments
WORK READINESS SOFT SKILLS
ASSIGNMENTS
PROJECT WITH PRESENTATION
EXAM OF MODULE 3

@ e G e e

MODULE 4:

DATA SCIENCE
« Object Oriented Programming
« Comprehension List
« Collections and Advanced Dictionary
« Set & its implementation
+ Data Modeling
* Data Visualization using matplotlib
* User Defined Libraries and Modules
» Advanced Libraries & Modules
* Importing & Exporting Data in Python
* Exception Handling
» Data Analytics Overview
* SQL & Excel Connectivities
* Natural Processing with Scikit Learn
* Data Manipulation with Pandas

@ e G e G e e

POWER BI
< |Introduction of Power Bl
+ Interface of Power BI
« Power Bl Mobile Apps

3 MONTHS

3 MONTHS

@ e G e e e G e e

P e G e

B e e G Y e

< Power Bl Services

« Export data in Power BI

» Shaping and Combining Data
» Modeling Data

> Analyzing Data

» Visualizing Data

» Interactive Data Visualization
» Power Bl Data Sources

> Relationships

» Calculations

* Working on Tools

» Creating Power Bl Reports

ASSIGNMENTS
GUI(TKINTER)

« Import the Tkinter module.

« Create the GUI application main window.

« Add one or more of the above-mentioned widgets
« to the GUI application.

- Enter the main event loop to take action against

each event triggered by the user.

ASSIGNMENTS

INTERVIEW TECHNIQUES
PROJECT WITH PRESENTATION
FINAL EXAM

JOB OPPORTUNITIES

SOFTWARE DEVELOPER
DATA ANALYTICS
GAMES DEVELOPER

DATA SCIENTIST

4181818

PROF. DIPLOMA IN COMPUTER
APPLICATION
DURATION: 12 MONTHS
MODULE 1: 3 MONTHS
COMPUTER FUNDAMENTALS
WINDOWS & OPERATING SYSTEM
OUTLOOK EXPRESS

MS-WORD

- Introduction of Word with its Interface

- Explain Tabs Briefly

> Shortcuts

> Mailmerge

» Page Setups(Page visualization & printing)
> Protections & Macros

MS-EXCEL

- Introduction of Excel

-~ Explain Interface

~ Shortcuts

- Diff b/w Functions & Formulas
~ Cell references

~ Operators

“ Basic Calculations

* Text Function

» Date & Time Function



<+ Mathematic Function

+ Logical Function

+ Conditional formatting

« Charts

+ Reports using Pivot Table
Protections

0y
X7

MS- POWERPOINT

Introduction of PowerPoint

Explain Interface

Shortcuts

Explain Tabs

Quiz Making

Designing & Formatting
Transitions

Album creation

Animations

Slide Master

FUNCTIONAL COMMUNICATION
ASSIGNMENTS & PRESENTATION
EXAM OF MODULE 1

MODULE 2:

DESKTOP PUBLISHING
CORELDRAW
- CoreIDRAW Basics And Interface
> Working on Layer
» Working on objects with its properties
» Working on Drawing tools
» Working on Tools with its Shortcut
Transforming Objects
Outlining & Filling Objects
“ Tracing & some other Effects
* Blending Objects
Applying Distortions
Applying Mesh Fills
Working with Text
Layer Setup & printing
Import and Export

% S o e e o e o ot o
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3 MONTHS
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PHOTOSHOP

Explain interface with Layers

* Making Selections with its inverse
“ Working with Mask

“ Working on Paths

“ Create & Modify path

“ Remove and change the background
“ Working on Tools

“ Special Effects

« Layer Setup & printing

« Import and Export

%
X7

ILLUSTRATOR
+ lllustrator Basics with its interface
« Selections
« Working on Layers
+ Working on Rulers and Guide
« Working on Stroke & color Filling
+ Special Effects
* Working on Drawing Tools
* Working with Mask
* Working on Paths

% S e % e o e o
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« Working on Tools
« Working with Text
< Import and Export

FUNCTIONAL GRAMMAR
PORTFOLIO SUBMISSION
ASSIGNMENTS & PRESENTATION
EXAM OF MODULE 2

MODULE 3:

WEB DESIGNING

HTML

Introduction of HTML
Basic Structure of HTML
Tags & its implementation
Attributes & Elements
Formatting

Lists & Tables

Form Design & validation
Calculator

3 MONTHS

CSS

= Introduction of css
* How to use CSS

CSS Types

CSS Selectors

Margins & Padding in CSS
Animation using CSS

»2D & 3D CSS

Navigation & Drop-down
Progress Bar

SlideShow

CSS Effects

CSS Layout

Pseudo classes & element

«Web Layout Design

DREAMWEAVER

« Defining a local site

« Creating a page in Layout view

« Inserting an image and a rollover image

« Working with tables in Standard view

+ Creating a link to another document

« Inserting assets from the Assets panel

« Inserting Flash Text and Flash Button objects

Creating and applying a template
Running a site report
Adding a Design Note

WORDPRESS

Introduction to build dynamic website and blogs
Installation of Word press on web server
Download and Install Add-ins Tools

Working on Tools

«Working on Themes
« Create, Update and Manage website
« Edit, Publish, and Modify the content of the website

WORK READINESS SOFT SKILLS
ASSIGNMENTS

PROJECT WITH PRESENTATION
EXAM OF MODULE 3
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MODULE 4:
WEB DEVELOPMENT

JAVASCRIPT
« Basic Programming
« Working on logical part of programming
« Variables & Constants
« Data types & Operators
« Control Statement
« Looping
« Switch case
« Functions
« JavaScript Implementation with HTML
« Events Handling

PHP
~ PHP Introduction and Basics
~ PHP Variables and Data Types
~ PHP Operators
~ Decision Making Statements
- PHP Loops
- Arrays and its functions
- String and its functions
- PHP Date time variables and functions
- PHP Functions
- Including files
» Establishing Connection and Error Handling
« Cookies and Session

P e e P P Y e G e e

MYSQL
» SQL Introduction
» SQL DML Commands
~ SQL DDL Commands
~ SQL Clauses
» SQL Logical Operations
« SQL Aggregate Functions
« SQL Wildcards
« SQL Aliases
= SQL Joins
+ SQL Case
+ SQL Stored procedures
<+ SQL Comments

ASSIGNMENTS

INTERVIEW TECHNIQUES
PROJECT WITH PRESENTATION
FINAL EXAM

JOB OPPORTUNITIES
COMPUTER OPERATOR
GRAPHIC DESIGNER

WEB DESIGNER
WEB DEVELOPER

X R R R 3

A RVRURY

PROF. DIPLOMA IN ADV. INFORMATION

TECHNOLOGY
DURATION: 18 MONTHS

MODULE 1:

COMPUTER FUNDAMENTALS
WINDOWS & OPERATING SYSTEM

3 MONTHS

P P P e e G e o e

3 o e Y e e S o

3 MONTHS

e G ol e e s P Y e e e

OUTLOOK EXPRESS

MS-WORD

~ Introduction of Word with its Interface

-~ Explain Tabs Briefly

« Shortcuts

« Mail merge

« Page Setups(Page visualization & printing)
< Protections

<« Macros

MS-EXCEL

» Introduction of Excel

» Explain Interface

~ Shortcuts

~ Diff b/w Functions & Formulas
» Cell references

> Operators

» Basic Calculations

» Text Function

» Date & Time Function

» Mathematic Function

> Logical Function

« Conditional formatting

< Charts

“ Reports using Pivot Table
» Protections

MS- POWERPOINT

~ Introduction of PowerPoint
-~ Explain Interface

~ Shortcuts

-~ Explain Tabs

- Quiz Making

- Designing & Formatting

~ Transitions

-~ Album creation

-~ Animations

« Slide Master

FUNCTIONAL COMMUNICATION
ASSIGNMENTS

PRESENTATION

EXAM OF MODULE 1

MODULE 2:
DESKTOP PUBLISHING

CORELDRAW

3 MONTHS

-~ CoreIDRAW Basics And Interface
-~ Working on Layer

-~ Working on objects with its properties
-~ Working on Drawing tools

-~ Working on Tools with its Shortcut
-~ Transforming Objects

- Outlining & Filling Objects

- Tracing & some other Effects

- Blending Objects

~ Applying Distortions

» Applying Mesh Fills

> Working with Text

« Layer Setup & printing

> Import and Export
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PHOTOSHOP

Explain interface with Layers
Making Selections with its inverse
Working with Mask

Working on Paths

Create & Modify path

Remove and change the background
Working on Tools

Special Effects

Layer Setup & printing

Import and Export

ILLUSTRATOR

lllustrator Basics with its interface
Selections

Working on Layers

Working on Rulers and Guide

« Working on Stroke & color Filling
« Special Effects

+ Working on Drawing Tools

« Working with Mask

< Working on Paths

+ Working on Tools

« Working with Text

0y
X7

Import and Export

FUNCTIONAL GRAMMAR
ASSIGNMENTS & PRESENTATION
PORTFOLIO SUBMISSION

EXAM OF MODULE 2

MODULE 3:

WEB DESIGNING
HTML

< Introduction & Structure of HTML
« Tags, Attributes & Elements

« Formatting

« Lists & Tables

« Form Design & validation

< Calculator

S e O o
SRR

« Navigation, Drop-down & Progress Bar

CSS

Introduction of css

CSS Types & Selectors
Margins & Padding in CSS
Animation using CSS

+ Slide show

R
X3

CSS Effects & Layout

= Pseudo classes & element

« Inserting an image and a rollover image

&

DREAMWEAVER
Defining a local site
Creating a page in Layout view

Working with tables in Standard view
Creating a link to another document
Inserting assets from the Assets panel

3 MONTHS

+ Inserting Flash Text and Flash Button objects

&

&

<

Creating and applying a template
Running a site report
Adding a Design Note
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WORDPRESS

« Introduction to build dynamic website and blogs
« Installation of Word press on web server

+ Download and Install Add-ins Tools

« Working on Tools

Working on Themes
Create, Update and Manage website
Edit, Publish, and Modify the content of the website

WORK READINESS SOFT SKILLS
ASSIGNMENTS

PROJECT WITH PRESENTATION
EXAM OF MODULE 3

MODULE 4:
WEB DEVELOPMENT

3 MONTHS

JAVASCRIPT

« Basic Programming

+ Working on logical part of programming
« Variables ,Data types & Operators

« Control Statement

Looping

Switch case

Functions

JavaScript Implementation with HTML
Events Handling

PHP

« PHP Introduction and Basics
« PHP Variables and Data Types

PHP Operators

Decision Making Statements

PHP Loops

Arrays and its functions

String and its functions

PHP Date time variables and functions

PHP Functions(pre-defined and user defined)
Including files

Establishing Connection and Error Handling
Cookies and Session

MYSQL

SQL Introduction
SQL DML Commands
SQL DDL Commands
SQL Clauses

“ SQL Logical Operations
+ SQL Aggregate Functions
“ SQL Wildcards

«SQL Aliases

“SQL Joins

“SQL Case

“ SQL Stored procedures

SQL Comments
ASSIGNMENTS & PRESENTATION
EXAM OF MODULE 4

MODULE 5:
MULTIMEDIA

3 MONTHS
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INDESIGN
* Modern Magazines Design
» Business Magazines
* Book Design, Bill Book
* Menu Cards
* Flyers

> e e e

SOUNDFORDGE

« To record ,edit , mix and restore audio
Pasting data , cutting , deleting ,trimming
mixing , floating and docking windows

ADOBE PREMIERE
- Effects
> Video titling & graphics
- Transitions
> Labels
- Libraries
» Direct publishing

P e G e e

ASSIGNMENTS & PRESENTATION
EXAM OF MODULE 5

MODULE 6:
PRE ACCOUNTING

3 MONTHS

TALLY PRIME
- Tally & Versions
~ Computerized Accounting
- Charts of Accounts
- Accounting Management
- Inventory Management
» Order Processing
* Vouchers
» Payroll
* Banking Features
* Budget
* Back-up & Restore Data
» Job Costing
“ Advanced Features
* Taxes : TDS, TCS
« GST

B P e e G e S e e

BUSY
« Basic Accounting Practice
«» Computerized Accounting
. Charts of Accounts
. Accounting Management
. Inventory Management
-~ Order Processing
- Vouchers
- Payroll
-~ Banking Features
-~ Advanced Features
TDS
- GST

X3

B e e e e e

OR

ADVANCED EXCEL
+ Advanced Shortcuts
« Advanced Conditional Formatting

X I I Y

X3

-~ Advanced Functions

-~ Lookup & Reference Functions(vlookup,

« hlookup,index,match,double vlookup, vlookup with
+ match,hlookup with match, index with match &

« xlookup)

+ Depreciation

« Garbage Cleaning

« Errors

+ Report(Pivot Table & Charts with slicer and timeline
= Working with Templates

» Sorting and Filtering Data

* Restrictions

> What If Analysis

» Array Calculation

+ Database Function

> Macro for automation

> Advanced Protections & Print Technique

ASSIGNMENTS

INTERVIEW TECHNIQUES

FINAL PROJECT &PRESENTATION
FINAL EXAM

JOB OPPORTUNITIES

COMPUTER OPERATOR
GRAPHIC DESIGNER
WEB DESIGNER

WEB DEVELOPER
ACCOUNTANT

GST EXECUTIVE

TALLY OPERATOR

4441881818




PROGRAMS CATALOGUE (2022-2023)
DIPLOMA PROGRAMS

S Course Months Adm.Fee CourseFee ExamFee/M
1 Prof. Diploma In Digital Marketing 6 600 45000 400
2 Prof. Diploma In Management Information System 7 600 45000 400
3 Prof. Diploma In Computerized Accounting 8 600 18000 400
4 Prof. Diploma In Pre & Post Accounting 8 600 20000 400
5 Prof. Diploma In Documentation & Graphic Designing 8 600 18000 400
6 Prof. Diploma In Computer Application 12 600 40000 350
7 Prof. Diploma In Comp. Accounting & E-Taxtation 12 600 40000 350
8 Prof. Diploma In Software Development 12 600 45000 350
9 Prof. Diploma In Adv. Information Technology 18 600 50000 350
CERTIFICATE COURSES
1 Certificate In Graphic Designing (coreldraw, Photoshop, InDesign, lilustrator) 4 500 15000 400
2 Certificate In Data Entry Operator 4 500 8000 400
3 Certificate In Adv. Data Entry Operator 5 500 10000 400
4 Certificate In Computerized Accounting 6 500 15000 400
5 Certificate In Web Designing 6 500 20000 400
SHORT TERM COURSES
1 Certificate in Computer Operations (MS-OFFICE) 3 300 5000 350
2 Certificate in Advanced Excel 1.5 300 5000 350
3 Certificate in Tally 2 300 6500 350
4 Certificate in Busy 1 300 4000 350
5 Certificate in Advanced Excel & Tally 3 300 10000 350
6 Certificate in Tally & Busy 3 300 10000 350
7 Certificate in E-Taxtation (E-TDS, E-ITR, E-GST, ROC) 4 300 15000 350
8 Certificate in Core JAVA 3 300 12000 350
9 Certificate in Advanced JAVA 2 300 15000 350
10 Certificate in Python (CORE) 3 300 12000 350
11 Certificate in Adv. Python (WITH SQL,POWER BI, TKINTER) 3 300 25000 350
12 Certificate in Photoshop 1 300 6000 350
13 Certificate in CorelDraw 1 300 6000 350
14 Certificate in InDesign 1 300 4500 350
15 Certificate in lllustrator 1 300 4500 350
16 Certificate in C/C++ 2 300 5000 350
17 Certificate in C & C++ 3.5 300 10000 350
18 Certificate in PHP & MYSQL 3 300 12000 350
ENGLISH COURSES
1 Intensive Spoken English Course 6 300 12000 400
2 Certificate in Functional English 4 300 7000 400
3 Certificate in Advanced English 3 300 7000 400




23 Years of Experience
Upgrade Yourself with Technologies

Tel. No.: 011-41814405

Name : Date :

Training Program : Student Coordinator :

Diploma in:

» Software Development

» Web Development

» Web Designing

» Financial / E-Accounting

» Digital Marketing

Diploma in MIS
5" Advanced Excel
15 VBA
IS SQL
15" Dashboard Designing

PYTHON (XI, XII)
DATA SCIENCE

SPOKEN

ENGLISH

Short Courses

% MS-OFFICE

# CCC (Govt. Cert.)

# ADVANCED EXCEL

% TALLY PRIME

* BUSY

% GRAPHIC DESIGNING

% C &C ++

% CORE JAVA

E- BOOKS ASSIGNMENT | LIVE PROJECTS | INTERNSHIP REalLUIHRZ\Z

FEATURES MOCK INTERVIEW SESSIONS | FUNCTIONAL COMMUNICATION CLASSES Rafiaalt- R0\ £-1e]8
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1576, First Floor

Naveen Shahdara, Delhi-32
Phone : 011-41814405
Website : www.w-tec.in
E-mail : info@w-tec.in

23

YEARS OF
EXPERIENCE
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